Virtual Gibbs Step-by-Step Tutorial

Stanford Student Shops

Stanford University
# Stanford PRL Virtual Gibbs Tutorial

## Table of Contents

- Introduction ................................................................................................................... 3
- Operation Sequence Sketches ...................................................................................... 4
- Getting Started ........................................................................................................... 5
- Exporting your Geometry ............................................................................................ 5
- Export Options ............................................................................................................ 6
- Importing into Virtual Gibbs ....................................................................................... 8
- Overview of Virtual Gibbs Menus .............................................................................. 10
- Setting Up a Part ......................................................................................................... 12
- Checking Workgroups ............................................................................................... 13
- Viewing Your Part ....................................................................................................... 14
- Creating a Tool List ................................................................................................... 15
- Machining the Parts .................................................................................................... 18
- Drilling Holes (Operations 1 & 2) ............................................................................. 19
- Pocketing (Roughing) (Operations 3 & 4)) ............................................................... 25
- Toolpath Rendering .................................................................................................... 28
- Contouring (Operations 5 & 6) .................................................................................. 30
- Two More Pockets (Operations 7 & 8) ...................................................................... 33
- Operation Summary .................................................................................................. 37
- Postprocessing ........................................................................................................... 38
- G-Code ....................................................................................................................... 41
- Things to Remember ................................................................................................. 41
Stanford PRL Virtual Gibbs Tutorial

Introduction

The following tutorial is presented as a guided tour of the Virtual Gibbs software used in the student machine shops for CNC machining. To help you get the feel of how to program a CNC milling machine with the help of Virtual Gibbs, this tutorial will guide you through the creation of half of the casing for a tape measure. The Vellum drawing of the tape measure case has already been prepared and should be available on the loft computers. Some of the geometry in this drawing may not make any sense in terms of what a tape measure looks like, but you will see in a later section of this tutorial how this geometry helps make programming tool paths on the milling machine easier.

It is recommended that you work through this entire tutorial as it gives a fairly detailed description of most of the functions you will need to use in Virtual Gibbs. Later as you become more familiar with the software, you can refer to the table of contents to review specific functions of the software.

This tutorial has been prepared using an example part which would be best cut on the Matsuura milling machine. As a result, many of the choices and selections made are most appropriate for the Matsuura. This tutorial is still fully appropriate for someone expecting to use one of the Anilam machines. Differences between the two procedures will be highlighted whenever possible.
Operation Sequence Sketches

operations 1 & 2 - drill & ream
operation 3 - pocket

operations 4 - more pocketing
operation 5 & 6 - rough & finish contour

operation 7 - pocket
operation 8 - pocket
Getting Started

This tutorial assumes the geometry of the part you intend to cut has already been created in Vellum or any other appropriate CAD (Computer Aided Design) package. You don't need to know how to use Vellum to work through this tutorial. The Vellum drawing has already been created, but you will definitely want to learn Vellum before trying to create your own parts. Learning Vellum is very quick and easy. A tutorial is available in the computer loft.

Exporting your Geometry

The first step in turning your Vellum drawing into a machined part is to 'export' the geometry information from Vellum out to Virtual Gibbs. Before doing so, there are a few things you should check to insure a successful and accurate transfer of information.

- There should be no grouped geometry in your Vellum drawing.
- It is good practice to divide your Vellum drawing up into different layers according to how you expect the part to be machined. This will become clear later in the tutorial.
- You should probably eliminate the construction lines in your drawing. Leaving them in will cause Virtual Gibbs to automatically adjust its working area to include the construction lines, which will often leave your part looking tiny on the screen.
- Make sure all lines are properly connected. Small gaps in a series of line segments will cause Virtual Gibbs not to perform certain operations. You can check the connections by zooming in on the union of each line set. Connections between arcs and lines, and between two arcs are particularly prone to error.

Having checked these points, you're ready to export.
Export Options

The Export command is found under the File menu. When you select this command, an Export window will appear like the one below. Select the DXF option. In some cases you may want to use the IGES export option, particularly if you are using 3D functions in Virtual Gibbs. (IGES translation also works well for ellipses and splines.) For this tutorial, and most parts you will create, use the DXF option.

If you check the Only Selected box, only the geometry you have selected with the mouse tool will be exported when you click OK. In general, you should make sure this is not checked, but occasionally you may have a very complicated drawing and you wish to export only a small portion. This feature will allow you to do so.
After OKing the previous window, you will be prompted to save the file with a .dxf extension. If you have exported a number of times, be careful not to overwrite any files you want to keep.

The following menu will appear next on your screen. This box affects only lines that have been created with non-default thicknesses - which you should avoid for Vellum drawings meant for CNCing. Leave the box unchecked and hit the OK button.
**Importing into Virtual Gibbs**

Once you have exported your geometry as a .DXF file, you are ready to launch Virtual Gibbs and import the geometry.

When you launch Virtual Gibbs, the program icon will appear in the center of the screen. Under the **File** menu, choose **New**. A dialog box will then ask you to name and save your new file. Your file will automatically be named `filename.VNC`. It's best to choose a name less than eight characters. Under the **File** menu once again, choose **Import**. The following dialog box will appear. From here you may open previously created ncCAD files, DXF, IGES or Point List (text) files by clicking the appropriate button. Find the `tape.DXF` file in **U:\Gibbs Tutorial** and open it.

![Image of file selection dialog box]

The file import options window will appear next. The check boxes should appear as below. If you have geometry that is not connected when it imports, try clicking the **Set Connect Range**. All lines within the distance you set will be joined. You can also change the plane into which your geometry is imported by changing the **Preferred Plane**. For now, make sure your dialog box appears as below and click **Process**.
Next you will see a window indicating the progress of the import process. The number of points, lines, curves and circles are reported as they are read in.

Provided there are no glitches, you should see the geometry of the part when the import process is complete. Check each workgroup to make sure the drawing is complete.

Overview of Virtual Gibbs Menus
This section is intended to help you find your way around Virtual Gibbs. When the tape measure drawing is imported, your screen should look like the one below. Virtual Gibbs can be navigated both through the menus at the top of the screen, and the menu bar to the right of the screen. You can zoom in on your geometry simply by depressing the mouse button and boxing the area you wish to zoom in on.

The menu to the right appears in the upper right hand corner of your screen. You have seven options.
<table>
<thead>
<tr>
<th>Button</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Control Button</td>
<td>![Image]</td>
</tr>
<tr>
<td>Geometry Creation Button</td>
<td>![Image]</td>
</tr>
<tr>
<td>Tool Creation Button</td>
<td>![Image]</td>
</tr>
<tr>
<td>Machining Operations Button</td>
<td>![Image]</td>
</tr>
<tr>
<td>View Control Button</td>
<td>![Image]</td>
</tr>
<tr>
<td>Cut Part Rendering Button</td>
<td>![Image]</td>
</tr>
<tr>
<td>Post Processing Button</td>
<td>![Image]</td>
</tr>
</tbody>
</table>

You can enable the **balloons** under the **Help** menu and run the mouse over any button and a description of the button will appear. The help balloons are very thorough and can be used anytime you want more info about specific functions.
Setting Up a Part

Click on the **Document Control Button**.

The following menu will appear:

![Menu Image]

From this box you can create new files and open old files, specify the machine type and stock material. You can also specify dimensions in inches or millimeters. In the bottom half of the box you can specify the stock size. Changing the stock size will only change the appearance of your part on the screen, but will not affect any
machining operations. Careful attention to the stock sizes will make the cut render views much more realistic and help you identify potential problems. The Z Clearance Plane is very important. This value indicates where the tool will rapid to immediately after a tool change. If this value is not set properly, there is potential for crashing the tool into your part or fixturing. Set this value to at least 1.0 inch.

The TI Change Position is used for CNC machines that do not have automatic tool changers. The tool will move to the location specified for all tool changes.

Make sure your dialog box looks like the one above and close the box by double clicking the square in the upper left hand corner.

Checking Workgroups

Click on the Geometry Creation Button.

You should see the following menu:

This menu presents you with all the CAD options for Virtual Gibbs. This tutorial does not cover geometry creation in Gibbs. If you are interested in learning how to draw your parts in Virtual Gibbs, find the Virtual Gibbs Tutorial that ships with the software and go through the Mill Tutorial in chapter 9. In our experience, Vellum is much easier to use than Virtual Gibbs for CAD drawings.

Click the W1 button in the upper right corner of this box. You will see the following dialog box:
This is a list of the workgroups present. By clicking the eye on the left side, you can make visible or hide the various layers. The highlighted workgroup is the active layer. You will only be able to perform machining operations on active layer geometry.

**Viewing Your Part**

Click on the **View Control Button**.

The following menu will appear on your screen.

Turn on the **Balloons** under the **Help** menu to discover the function of each of these buttons. Play with the various views available.
Creating a Tool List

A tool set consisting of end mills, drills, reamers - and any of the tools you want to machine your part needs to be defined before you can continue. Click on the **Tool List Button**.

![Tool List Button](image)

Double click on the first tile position as shown to the left. This will bring up a tool menu like the one shown below.

![Tool Menu](image)

The first tool we will use to machine the tape measure case is a 0.120" drill, to drill out the bosses of the case. A drill slightly smaller than 0.125" is being used so the hole can be precisely reamed in a later operation.

The boxes in the picture above are all numbered. As the tools are defined, a tool icon will appear in the box, and the number associated with that box corresponds to the tool position on the Matsuura tool changer. If you are working on one of the Anilam milling machines, that number is really just a label that is associated with that tool. You will need to remember which number corresponds with which tool. The Anilams will prompt you by number for the tool when it is needed in a particular milling sequence.

Click on the **Drill** icon as shown below, and change the diameter to 0.120" as shown. Make sure the **Tool Material** is HSS (High Speed Steel). Most tools in the Stanford shop are made of high speed steel, however, if you are using carbide or a special coated tool, choose the material type from the pull down menu. This is not where you enter the type of material you are machining.
Make sure the spindle is spinning in the proper direction (CW - clockwise). It is important to always check the direction - Virtual Gibbs will open with whatever defaults the previous user has left!

The **Included Tip Angle** refers to the included angle of the point of the drill. It is entered as 120 above, and this is correct for most drills.

The **# Flutes** box is where you specify how many cutting edges your tool has. Most drills have two, while many end mills have 2, 4, 6 or sometimes as many as 8. In general, a greater number of flutes reduces the **chip load** - how much material each flute will need to cut. In general, two flutes are good for plastic and aluminum, and four or more are useful while machining steel.

The **TI Len Off#** is set by Virtual Gibbs, and **CRC Offset#** should be set to match the TI Len Off#.
When you are finished, your tool list should look like the one below:

- 0.120" drill bit
- 0.125" reamer
- 0.250" finish end mill (fEM)
- 0.1875" finish end mill (fEM)
- 0.125" finish end mill (fEM)

When you define the end mills, the only information you will need to enter is the diameter of the tool. Keep in mind that many of the tools in the Stanford shop are reground and are not the exact size specified on the shank.

Once you have finished defining your tool set, you can begin machining. Close the last tool dialog box. You can review the tool specifications by using the Tool List Summary in the menu under the file name. The list should look like the one below.
Machining the Parts

Click on the **Machining Button**.

Three menus will appear. Your screen should look like the screen below. The **Process List** is displayed in the bottom left-hand corner of the screen. The **Operations List** appears in the right-hand corner, and the **Machining Palette** is along the bottom.

The Machining Palette contains four **Function Tiles**. The available functions are Drilling, Contouring, Roughing (pocketing) and Thread milling. **Process Tiles** are created by dragging a **Tool Tile** and a **Function Tile** to a process list location. **Operation Tiles** are automatically created from Process Tiles when a cut shape is selected, and the **Do It** or **Redo It** button is depressed. That may or may not make sense, so let's step through the machining process, and the process will hopefully become clear.
Drilling Holes  (Operation 1 & 2)

Our first procedure is to drill holes. If you were actually going to make this part, you should define a center drill and center drill all of the holes first. Since the purpose of this tutorial is to teach Virtual Gibbs, not how to drill, we'll skip the center drill operation.

We are going to define the two drilling processes before we define the operations. By doing this, the two drilling processes will always be linked as a package of operations.

Drag the icon of the 0.12" drill bit from the Tool Palette down to the first spot in the Process List.

Next drag the drill function tile from the Machining Palette and drop it on top of the first spot on the Process List. (This is the same tile onto which you just dropped the drill bit icon.)
The following menu will appear, asking you to define the machining process. Enter the values as they appear below:

![Process #1 Drilling Menu](image)

If you are ever unsure of what the values in a dialog box refer to, turn on the balloon help. Find the boxes discussed below using the balloon help.

The **Entry/Exit Cycle** refers to how the tool enters and leaves the part. For most machining operations you want to **feed** into the part as you are cutting, and **rapid** out since you’re not cutting. In this operation we are drilling a small hole in plastic. If we were to drill the full depth of the hole, we might run the risk of melting the plastic due to the heat generated, and ruin the hole. Gibbs allows you to "peck" the hole, meaning
that a fraction of the full hole depth is drilled, and then the drill is retracted for a moment, allowing the tool and material to cool. Here a full retract has been chosen to allow maximum cooling, but if you were drilling steel, you might choose a Chip Breaker cycle, which would cause the drill to retract only a slight amount from the last surface to break the chip and clear the hole. The depth drilled on each peck is specified in the Peck box. The Clearance box determines how far the drill is retracted before the next peck.

Clearance planes are Z positions to which the tool is raised between drilled hole positions. Gibbs uses multiple clearance planes for efficient machining in a production environment. We only have to ensure that the clearance planes are always positive and that they are high enough to clear any clamps or fixtures with which we will be holding the part. Set the Operation Clearance Plane to 1.0 inch, and the Exit Clearance Plane to 0.1 inches.

Since we want a full depth of 0.63 inches, set the finished depth to this value. Gibbs will then calculate the sharp tip depth (the depth of the hole from drill tip to surface) and the spot diameter (the diameter of the hole left at the surface).

The drill surface Z box refers to the top surface of the part to be drilled. You might, in theory, want to mess around with this if you were machining a stepped part, but in general, program all of your cuts from a global Z reference, and don't change it. Later you will see an application where you might want to change this value.

Make sure the Flood coolant is turned off, and set the RPM to 6000. This is the fastest spindle speed of the Mastuura. On the Anilam Crusader machines, the spindle speed is controlled by the user, so the RPM is not important.

Close the box and drag the reamer icon to the second tile of the process list. Drag the drilling icon to the second tile of the process list as well, and the process list should now look like the picture to the right.

The numbers in the boxes (1 and 2) indicate the number of the tool to be used. The machining icon appears below the tool number - in this case the drilling icon.

Every time you choose a process, a dialog box will appear asking you to define what you will do with the tool. Make the finish Z depth of the reamer a few thousands shallower than the drilled hole so there is no chance the reamer will touch the bottom of
the hole. A depth of 0.625" should be fine. Virtual Gibbs automatically assumes that the entry/exit cycle for a reamer is feed in/feedback out, which is correct. Reamers should always turn very slowly, so turn the **RPM** down to 300.

![Process #2 Drilling](image)

Make sure the active layer contains the holes we want to drill. You can check this by depressing the Geometry Creation Button and checking the workgroups like we did earlier. Make sure the 'DRILLEDHOLES' layer is highlighted.

![Workgroup](image)
Choose each of the four holes in the center of the bosses by holding the shift key down as you select each of the holes with the mouse.

When one of the two processes we have defined is highlighted, we will be able to press the **Do It** button on the Machine Process palette.

Notice that both the drilling and reaming processes have been completed and moved to the Operations Pallette. Because we defined both of these processes together before performing a machining operation, they are linked as a kind of a "drilling package." Although they appear as two separate operations, if you delete one, both operations will be deleted. This defining of processes can be very useful for drilling if you need to center drill, drill, and ream a series of holes. If you are performing different operations on the same geometry, this method will save you time and help guard against changing one operation without considering its effects on the other operations. (For example, you
wouldn't want to ream hole before drilling it! This grouping of operations is not limited to drilling, as you will see later in this tutorial.

The screen should look like the following:

Notice the toolpaths that are drawn on the screen. Orange lines, both dashed and solid, represent the operation toolpath. Dashed orange lines signify rapid moves within the toolpath, while solid orange lines signify feed moves. The gray lines represent inter-operational moves and approach/retract moves. Again, rapid moves are dashed and feed moves are solid lines.
Pocketing (Roughing) (Operations 3 & 4)

The tape measure case we are making has four bosses which protrude 1/8" from the top surface of the part. (Refer to the Operation Sequence Sketches in the front) If you look at the drawing on your screen, you'll notice a third outline outside the tape measure body. We are going to pocket inside this shape, down to a depth of .125", leaving behind the bosses. This will machine the top surface of the edge of the case, leaving .125" bosses protruding. This is also an example of how you may need to construct geometry that isn't part of your design, but is necessary to facilitate the machining of our tape measure case.

Remove the processes we have just completed by dragging them to the trash can.

Drag the 0.25" fEM to the first position in the Process List. Select the Pocketing or Roughing process and drag it to the same position.

The following menu will appear. Once again, turn on the balloon help and check out the various information on the roughing dialog box. Make sure you turn off CRC (cutter radius compensation), and set the finish depth to 0.125".

Notice that we could define a certain amount of stock to be left on the pocket and island walls by entering an amount in the boxes. This is useful if you want to hog out material and leave some stock on the walls to take off with a finishing pass at the end. A finishing pass is almost always a good idea because it greatly improves surface finish and machined accuracy.

The box should look like the one below.
Turn off all the layers except for "TOPBOSSES" which contains the geometry we will be machining.

Click anywhere on the outside shape. When using this pocketing function, it is only necessary to select one feature of the contour. Because pocketing can only be performed on completely closed shapes, you only need to indicate which shape will be pocketed.

While holding down the shift key, select each of the four bosses within the pocket. Click on the Do It button, and watch the toolpaths that are created. If the Do It button reads Redo It, make sure one of the first two operations in the Operations menu is not still highlighted, otherwise you will replace these operations with the one you are about to perform.

Your screen should look like the following:
We’ve completed operation 3, let’s move on to operation 4. Make only the 'INNERPROFILE' workgroup visible and the active layer. Notice that as you change active layers, the toolpaths associated with the highlighted operation tile will appear. If no operation tile is highlighted, all toolpaths will disappear.

Remove the processes we have just completed by dragging them to the trash can.

Select the 0.25" finish endmill once again and drag it to the first position in the Process List. Select the Pocketing or Roughing process and drag it to the same position.
The box above should look familiar by now. Notice the changes that were made. The design of this case calls for the internal pocket to be 0.5” deep. That's too much to cut in one pass, so we have chosen to cut to the proper depth in three passes. If the finish Z depth is set to -0.5" and the **Desired Z Step** is 0.125", Virtual Gibbs will determine how many **Passes** are required to reach the requested depth. Remember that we already took off 1/8" in the last pocketing operation, so the top surface of the material has been set to 1/8" below our zero coordinates.

Like before, click anywhere on the outside shape. While holding down the shift key, select each of the four bosses within the pocket. Click on the **Do It** button, and watch the toolpaths that are created.

### Toolpath Rendering

Although we can see the generated toolpaths, it's difficult to tell if the number of passes is correct. Click on the **View Control Button** and select isometric view. Click on the **Cut**
**Part Rendering Button.** The part will no longer appear in wireframe, but instead will be displayed in 3-D solid model. The Cut Part Rendering Palette below also appears on the screen. This palette gives the user control over the cut part rendering processes. Turn on the balloon help and explore the palettes functions.

A part can be rendered anytime after operations have been created. The stock is always drawn in shades of blue. Highlighted operations will render in shades of yellow, while all other operations will render in shades of gray. Red will be displayed when non-cutting tool surfaces or rapid moves hit the material. Your screen should look like the screen below. Notice how we did not choose a very appropriate stock size. You can go back and change this at any time, as the stock size affects only the rendering and not any of the machining processes.
Click on the Cut Part Rendering button again and the part will return to wireframe. Return the piece to a top view for the next operation.
Contouring (Operations 5 & 6)

The next step is to rough contour the outside of the tape measure. Afterwards we will take a finish contour pass to clean up the surface. First set the active workgroup to 'OUTERPROFILE', and make the rest of the workgroups invisible. As before, choose the tool you will use and drag it to the process palette. Make sure you have cleared the palette of earlier processes. Always use the largest tool that you can for an operation, as this will allow heavier cuts and reduce chatter. The 0.25” endmill will work fine for this operation. Choose the 0.25" endmill and select the contour machining process.
The above box should be familiar to you by now. Enter the information shown above. Notice we are machining to a depth of 0.625" in four passes, and that the Entry/Exit Connect is on as well.

Making multiple cuts to achieve a specific depth will leave a mark on the part at each elevation. So that these marks don't show up on the part, we are going to leave 0.005" of extra stock on the part, and then make one more cut at full depth to remove this 0.005" along with the marks. Since these two processes are associated, we will do them together. Drag the 0.25" endmill to the second tile in the Process List and drag the Contour Machining tile on top. Your process list should look like the one below:

The following dialog box appears. Notice we are now cutting one pass at 0.625" depth, with no stock left on.
Click anywhere on the outside of the shape and the picture below will appear. We need to specify which side of the profile we want to contour and the direction of the cutter. Choose the outside contour and clockwise travel as shown below. Remember that choosing a cutter direction specifies climb or conventional cutting.

Click on Do It and the tool paths appear. Since it is difficult to be sure the finishing pass is correct, let's go to the Rendering mode again. But before we do, let's specify a stock size that will allow us to better see the tool paths. Click on the Document Button and type in the values below.
Now change the view to isometric and click on the Cut Rendering Button. You may need to go step by step through the tool paths to be sure the finish pass removes the final 0.005” of stock.

**Two More Pockets (Operations 7 & 8)**

We're not introducing any new machining icons, so not every window from here on will be printed. The next operation is to machine the cutout where the tape measure lock would be placed. Use the 3/16" endmill to get into the small spaces required.

Make 'SWITCHCUTOUT' the active layer and set up the program for a pocketing operation with the 3/16" endmill. Set your values as below, noting we are cutting to a depth of 0.375" in two passes. It also a good idea to be sure that the Cut Width value is not greater than half the diameter of the cutting tool. This value controls how far over the cutting tool will step on its next pass. For this operation, set the 90° Radius and Line values to zero.
Click on the outside of the contour, hold the shift key down and click on the boss. Hit Do It and the tool paths are generated.

We're using the same trick here as we used back in Operation 3. The pocket was drawn to have the same length as the slot. By cutting inside the pocket and leaving behind the pin as a boss, the slot and the pivot pin are cut in one operation. You must plan for this back in Vellum.

You screen should appear as below. You can view the rendered part using the Cut Part Rendering Button at this point if you would like to check the part.
The last feature to be machined is the small cutout where the tape exits the case. A small 0.125" endmill is used to avoid the boss while machining this feature.

Make 'TAPESTOPCUTOUT' the active layer and set up the program for a pocketing operation with the 0.125" endmill. Set your values as below, noting we are cutting to a depth of 0.3125" in three passes.
Click anywhere on the contour and hit Do It. That's it!
Operations Summary

At this point you can check the Operations Summary under the title menu to review the operations.
Postprocessing

The last step to perform before machining our part is to 'postprocess' the toolpath information that we've created in Virtual Gibbs into a file that the milling machine will understand.

To begin click on the **Post Processor Button** at the bottom of the menu palette.

The following menu will appear:

If you are processing for the Matsuura, you should check the **Insert Comments** box. If you are processing for one of the Anilam Crusaders or the Roland, make sure the box is **not** checked. If the **Insert Optional Stops** button is checked, the machine will pause at each tool change until you press the start button.
Click on the **Post Processor Selection Button**

![Post Processor Selection Button](image)

This brings up a dialog box asking you to select a postprocessor.

![Gibbs Postprocessors](image)

The Matsuura has a Yasnac controller, so that's the postprocessor you should choose for this demo. If you were making something for the Crusader, you would pick that postprocessor.

Next click on the **Program Name Button**

![Program Name Button](image)

This brings up the dialog box asking you to pick a name for the postprocessed file and to save it.
Click on the **Text Window Button**. This will allow you to watch the G-Code text scroll by as it is generated.

Click on the **Process** button.
G-Code

The last thing you should do is have a look at the G-code that Virtual Gibbs has generated for you. While beyond the scope of this tutorial, G-code is quite readable by humans who have learned it. A listing of all pertinent G-codes is available on the shop website. If you plan on doing much CNC work, it is highly recommended that you familiarize yourself with at least basic G-code so you can troubleshoot your programs. Unless you are very lucky (or very good) you will go back to your program to make changes. Some of the changes may be quickly and easily done on the G-code level.

Things to Remember

Here are some helpful hints and things to remember while using Virtual Gibbs.

1) Virtual Gibbs will retain the values set by the last user. Don't assume the default values will work for you. Check all values!

2) The Matsuura will not run with a G54 in the code. Search and replace it in MS Word to fix this problem.

3) An M4 in your G-code causes the spindle to spin in reverse. Make sure you don't have an M4 in your code.

Revision history

v1.0          Ken Martin          Jan 24/94